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• Introduction – Nouveau processus Gestion des Achats Indirects

• Nouvelle plateforme Coupa

• Simplifier notre processus d’achat

• Améliorer la collaboration avec nos fournisseurs

• Optimiser nos méthodes de travail

• Espace Fournisseurs

• Prochaines étapes et conclusion 

Socialiser la nouvelle offre de service du département des achats corporatifs et assurer votre compréhension des 

changements touchant l’approvisionnement qui entreront en vigueur prochainement.

Agenda 

Objectif

Objectif de la session



Pourquoi faire évoluer nos façons de faire au niveau des achats?

Pour être plus efficaces, performants et mieux répondre aux besoins d’affaires.

Mise en place 

de nouvelles 

politiques et 

gouvernance

Harmonisation 

du processus 

d’achat avec 

Coupa

Révision de la 

structure 

d’équipe et de 

son modèle de 

livraison

Centralisation 

de la relation 

avec nos 

fournisseurs

Soutien et documentation - Olymel S.E.C.

https://www.olymel.ca/fr/espace-fournisseur/soutien-et-documentation/


Achats Indirects
Les achats indirects font référence à l’acquisition de biens ou de services qui ne sont pas directement liés au processus de production*. Ces achats demeurent essentiels      

pour le fonctionnement de l’établissement. Ces achats sont souvent nécessaires pour soutenir les opérations, la maintenance, la gestion et le bien-être des employés, mais ils 

ne font pas partie intégrante du produit final. 

Entretien général bâtiment 

▪ Services d’opération du traitement d’eau 

▪ Travaux plomberie mineure (toilette, évier, 

etc.)

▪ Électricité générale (lampe, fluo, etc.) 

▪ Service pompage 

▪ Petites réparations bâtiment (réparation 

fenêtre, travaux peinture, etc.) 

▪ Entretien de la cour (déneigement, 

paysagement

Consommables indirects 

▪ Produit chimique pour le traitement d’eau 

▪ EPI (Équipement de protection 

individuel): gants, casques, protège 

oreille, lunettes, bottes, uniformes, etc.

▪ Fourniture d’entretien (papier à main, 

savons, produit nettoyant, etc.) 

▪ Fourniture de laboratoire 

▪ Fourniture de bureau 

▪ Encre pour imprimante d’étiquettes

▪ Fourniture d’assainissement 

▪ Cadenassage, scellé pour camion 

▪ Radio émettrice (walkie-talkie) 

▪ Agent dénaturant 

▪ Outils d’aide à la production (ciseaux, 

couteaux, pelles, tamis, etc.)

▪ Poubelles de rejet 

▪ Palettes

Exemples d’achats indirects 

Autres achats indirects

▪ Frais professionnels (finances, 

▪ légaux, RH)

▪ Services de consultants

▪ Abonnement et cotisation

▪ Main-d’œuvre externe

▪ Transport de main-d’œuvre (autobus, 

▪ taxi)

▪ Dépenses de marketing et vente

▪ Dépenses d’entreposage externe

▪ Dépenses de recrutement et 

▪ d’embauche

▪ Dépenses pour travailleurs étrangers

▪ Mobilier de bureau

▪ Énergie

▪ Communication

▪ Location matériel roulant court terme 

▪ (lift-camion)

▪ Dépenses informatiques

*Certaines exceptions s’appliquent



Achat Capex (DM)
Le déboursé majeur comprend, entre autres, des locations de toutes natures et des acquisitions d'actifs immobilisés et des dépenses non courantes. 

Exemples d’achats déboursés majeurs 

Location 

▪ Location long terme Camion

▪ Location long terme Voiture

▪ Location équipements mobiles (Chariot 

élévateur)

Actifs immobilisés 

▪ Équipements productions, bouilloire, 

fumoir, laboratoire 

▪ Construction de bâtiments (usine, étable, 

porcherie, remise, garage, abri)

▪ Amélioration terrain, amélioration locative, 

terrain

▪ Chariot élévateur

▪ Matériel roulant (neuf et usagé)

▪ Stationnement et pavage

▪ Équipement entreposage et distribution

▪ Équipements informatiques

▪ Logiciel Mobilier bureau et cafétéria 

▪ Équipement de réfrigération

Dépenses majeures non courantes 

▪ Réparation de toiture, planchers, murs, 

compresseurs

▪ Chaines d'abattage, chaines 

d'éviscération

▪ Réaménagement intérieur des bâtiments



   Nouvelle plateforme Coupa

Coupa offre de nombreux avantages pour Olymel et ses fournisseurs

• Coupa en bref - Olymel S.E.C.

https://www.olymel.ca/fr/espace-fournisseurs/coupa-en-bref/


Méthodes de communication possibles avec Coupa

• cXML

• Échange d’informations entre systèmes (Approvisionnement Olymel et 

fournisseurs)

• CSP

• Coupa Supplier Portal

• SAN

• Supplier Actionable Notification

• Transmission par courriel

   Nouvelle plateforme Coupa – Comment échanger l’information
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Avis demandant une action du fournisseur (SAN)
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LÉGENDE

Veuillez noter que les icônes suivantes sont utilisées tout au long du présent document pour vous 
aider à apprendre les nouveaux processus commerciaux :

 Note importante : des renseignements importants à noter ou à retenir

 

 Conseil : un conseil important ou des renseignements utiles



12

Icônes couramment utilisées

Contester

Modifier

Supprimer

Rechercher

Ajouter une ligne individuelle

Annuler

Accueil

Créer une facture

Créer une note de crédit

ICÔNES
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Terme clé Description

Article du catalogue Article ajouté à Coupa par l’Approvisionnement avec un prix négocié. Ces 

biens peuvent être achetés par les demandeurs.

UDM Unité de mesure

Devise La devise des articles pour le prix indiqué. Les utilisateurs voient le prix 

dans leur devise par défaut.

Catégorie d'Achat Une catégorie pour classer les dépenses

Portail des 

fournisseurs Coupa 

(CSP)

Une plateforme en ligne gratuite fournie par Coupa pour permettre aux 

fournisseurs de gérer leurs interactions et leurs transactions avec leurs 

clients qui utilisent Coupa.

Lorsqu’ils s’inscrivent, les fournisseurs peuvent :

• Recevoir des bons de commande et envoyer des factures

• Créer et distribuer des catalogues électroniques propres aux clients

• Gérer les profils d’entreprise et les renseignements de paiement

TERMINOLOGIE importante
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À la fin de ce cours, vous pourrez :

• Vous inscrire au portail CSP

• Obtenir un aperçu de la page d’accueil du portail CSP

• Inviter de nouveaux utilisateurs et gérer les utilisateurs existants dans le portail CSP

• Visualiser et accuser réception d’un bon de commande (CSP)

• Créer une facture à partir d’un bon de commande

• Ajouter les taxes au niveau de l’en-tête de la facture

• Ajouter les taxes au niveau des lignes de la facture

• Créer une note de crédit

• Résoudre les différends liés aux factures

• Afficher et répondre à un avis de bon de commande demandant une action du 
fournisseur (SAN)

• Participer à une activité d’approvisionnement et soumettre des réponses

OBJECTIFS du cours
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Leçon 1
Inviter et inscrire des fournisseurs 

dans le portail des fournisseurs de 

Coupa (CSP)
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Voici les étapes du processus d’invitation et 
d’inscription de fournisseurs dans le portail CSP.

1. Cliquez sur le bouton Rejoindre Coupa sur 
l’invitation que vous recevrez par courriel.

2. Saisissez le mot de passe dans le champ Mot 
de passe (obligatoire).

3. Saisissez le mot de passe de nouveau dans le 
champ Confirmer le mot de passe 
(obligatoire).

4. Cochez la case d’acceptation de la politique 
de confidentialité et des conditions d’utilisation 
(obligatoire).

5. Cliquez sur le bouton Créer un compte.

INVITER ET INSCRIRE DES FOURNISSEURS 
DANS LE PORTAIL DES FOURNISSEURS DE 
COUPA (CSP)

5

4

32

1
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6. Entrez le code de vérification unique et cliquez 
sur le bouton Suivant.

7. Sélectionnez l’option « Non, continuer la 
création d’un nouveau compte ».

8. Cliquez sur le bouton Suivant.

INVITER ET INSCRIRE DES FOURNISSEURS 
DANS LE PORTAIL DES FOURNISSEURS 
DE COUPA (CSP)

6

8

7
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9. Cliquez sur l’hyperlien Mettre à jour le profil 
pour mettre à jour les renseignements requis.

10. Dans la section Adresse principale, entrez les 
renseignements appropriés dans le champ 
Ligne d’adresse 1.

11. Entrez la ville.

12. Entrer la province ou l’État.

13. Entrez le code postal.

14. Sélectionnez le pays ou la région dans le 
menu déroulant.

15. Remplissez le champ Numéro de taxes.

INVITER ET INSCRIRE DES FOURNISSEURS 
DANS LE PORTAIL DES FOURNISSEURS DE 
COUPA (CSP)

10

15

14

13

1211

9
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16. Sous Zones desservies, sélectionnez la ou les 
régions en question.

17. Cliquez sur le bouton Enregistrer les 
modifications.

INVITER ET INSCRIRE DES FOURNISSEURS 
DANS LE PORTAIL DES FOURNISSEURS DE 
COUPA (CSP)

17

16
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18. Cliquez sur l’hyperlien Gérer les entités 
juridiques.

19. Cliquez sur le bouton Ajouter une entité 
juridique.

20. Saisissez le nom de l’entité juridique en 
question (obligatoire).

21. Sélectionnez le pays ou la région dans le 
menu déroulant (obligatoire).

22. Cliquez sur le bouton Continuer.

INVITER ET INSCRIRE DES FOURNISSEURS 
DANS LE PORTAIL DES FOURNISSEURS DE 
COUPA (CSP)

18

22
21

20

19
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23. Cliquez sur le bouton Enregistrer et 
continuer.

INVITER ET INSCRIRE DES FOURNISSEURS 
DANS LE PORTAIL DES FOURNISSEURS DE 
COUPA (CSP)

23
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24. Remplissez le champ Ligne d’adresse 1 
(obligatoire).

25. Entrez la ville (obligatoire).

26. Sélectionnez la province ou l’État dans le 
menu déroulant (obligatoire).

27. Saisissez le code postal (obligatoire).

INVITER ET INSCRIRE DES FOURNISSEURS 
DANS LE PORTAIL DES FOURNISSEURS DE 
COUPA (CSP)

25

24

26

27



23

28. Saisissez le numéro de TVQ ou cochez la 
case « Je souhaite utiliser cette information 
comme numéro fiscal local » (obligatoire).

29. Cliquez sur le bouton Enregistrer et 
continuer.

INVITER ET INSCRIRE DES FOURNISSEURS 
DANS LE PORTAIL DES FOURNISSEURS DE 
COUPA (CSP)

Les numéros fiscaux seront stockés dans le PGI 

d’Olymel; la valeur saisie ici n’aura aucune incidence sur 

le paiement des factures soumises.

29

28
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30. Sélectionnez le type de paiement dans le 
menu déroulant (nous avons choisi 
« Adresse ») (obligatoire).

31. Cliquez sur le bouton Enregistrer et 
continuer.

INVITER ET INSCRIRE DES FOURNISSEURS 
DANS LE PORTAIL DES FOURNISSEURS DE 
COUPA (CSP)

Les renseignements sur les versements seront 

conservés dans le système PGI d’Olymel; l’adresse de 

versement entrée dans le portail CSP n’auront aucune 

incidence sur le paiement des factures soumises.

31

30
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32. Vérifier les détails de l’adresse de versement.

33. Cliquez sur le bouton Suivant.

34. Vérifier les détails de l’adresse.

35. Cliquez sur le bouton Terminé.

INVITER ET INSCRIRE DES FOURNISSEURS 
DANS LE PORTAIL DES FOURNISSEURS DE 
COUPA (CSP)

34

35

33

32
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36. Vous vous trouverez alors à la page 
Configuration terminée.

37. Cliquez sur le bouton Terminé.

INVITER ET INSCRIRE DES FOURNISSEURS 
DANS LE PORTAIL DES FOURNISSEURS DE 
COUPA (CSP)

37

36
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Leçon 2
Aperçu du portail CSP
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Lorsque vous ouvrez une session dans le portail CSP, allez à la 
page d’accueil pour constater les divers onglets accessibles.

1. L’onglet Accueil vous permet de visualiser et d’améliorer 
votre profil public, ainsi que d’accéder à la liste des clients 
avec lesquels vous êtes en contact.

2. L’onglet Profil fournit des conseils sur la façon de créer et 
de gérer votre profil, notamment sur la gestion des 
adresses, des entités juridiques et des personnes-
ressources.

3. L’onglet Commandes vous permet de visualiser et 
d’accéder aux bons de commande.

4. L’onglet Factures permet de créer et de gérer des 
factures.

5. L’onglet Configuration offre des options pour gérer les 
utilisateurs, les adresses de paiement et les demandes de 
fusion.

6. La section Activité récente vous permet de connaître 
l’état le plus récent de vos bons de commande et de vos 
factures.

7. Vous pouvez cliquer sur l’hyperlien Afficher le profil pour 
afficher et modifier les détails de votre profil.

PAGE D’ACCUEIL DU PORTAIL CSP

Seules les sections mentionnées ci-dessus seront utilisées pour Olymel.

1

2 3 4

5

6

7
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1. Placez votre curseur sur NOTIFICATIONS.

2. Cliquez sur l’hyperlien Afficher toutes les 
notifications. Sur cette page, vous pourrez 
consulter toutes les notifications qui vous ont 
été envoyées et gérer vos préférences de 
notification.

NOTIFICATIONS

Veuillez utiliser la fonction de clavardage avec l’équipe 

de soutien de Coupa pour obtenir du soutien 

technique.

2

1
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Leçon 3
Gestion des utilisateurs 

(Paramètres des 

fournisseurs)
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Le portail des fournisseurs vous permet d’inviter 
d’autres utilisateurs de votre organisation à s’inscrire 
au portail CSP.

1. Pour inviter les utilisateurs à votre compte du 
portail CSP, cliquez sur l’onglet Configuration.

2. Pour inviter un nouvel utilisateur, allez à la 
section Utilisateurs et cliquez sur le bouton 
« Inviter un utilisateur ».

Une nouvelle fenêtre s’affichera.

3. Saisissez les informations de l’utilisateur (nom 
et courriel) (obligatoire).

4. Ensuite, sélectionnez les autorisations de 
l’utilisateur (dans ce cas-ci, les autorisations 
désignent des « accès aux modules »).

5. Sélectionnez les clients auxquels l’utilisateur 
devrait pouvoir accéder.

6. Cliquez sur Envoyer une invitation. L’employé 
recevra immédiatement un avis par courriel, 
avec un lien pour s’inscrire. 

GESTION DES UTILISATEURS – INVITER 
UN NOUVEL UTILISATEUR 

Le nouvel utilisateur n’apparaîtra qu’une fois qu’il aura 

accepté l’invitation. 6

5

4

3

2

1
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La gestion des utilisateurs actuels s’effectue dans le 
même module (Configuration > Utilisateurs).

1. Si vous devez gérer des utilisateurs, cliquez 
simplement sur Modifier pour accéder aux 
options de gestion des utilisateurs.

Une nouvelle fenêtre s’affichera.

2. Dans le module de gestion des utilisateurs, vous 
pouvez modifier les renseignements sur 
l’utilisateur, les autorisations accordées et les 
clients auxquels les utilisateurs sont associés.

3. N’oubliez pas de cliquer sur Enregistrer pour 
appliquer les changements que vous avez 
apportés.

4. Au besoin, vous pouvez désactiver un 
utilisateur en particulier en cliquant sur 
Désactiver l’utilisateur.

GESTION DES UTILISATEURS – GESTION DES 
UTILISATEURS ACTUELS 

Veuillez noter que le système exige au moins deux utilisateurs actifs pour pouvoir 

désactiver l’un d’entre eux. De plus, s’il n’y a qu’un seul utilisateur dans le portail CSP, il ne 

peut être désactivé.

4 3

2

1

Supplier
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Votre entreprise peut avoir plusieurs comptes ou profils 
dans le portail CSP, surtout si plusieurs utilisateurs se sont 
inscrits ou ont été invités avec différentes adresses de 
courriel.

1. Cliquez sur la section Configuration, vous trouverez 
une option de demande de fusion si votre entreprise 
compte plus d’un compte ou profil dans le portail CSP.

2. Cliquez sur l’hyperlien Demandes de fusion.

3. Saisissez l’adresse de courriel que vous souhaitez 
fusionner.

4. Cliquez sur le bouton Demander la fusion.

5. Veuillez noter que les suggestions de fusion de 
compte sont fondées sur le domaine de courriel. 
Autrement dit, le système suggère automatiquement la 
fusion de tous les utilisateurs avec un domaine de 
courriel particulier, comme @exemple.com.

Une fois qu’un compte est fusionné, il ne peut pas être défusionné.

Veuillez noter que les comptes ayant la même adresse de courriel 
seront fusionnés automatiquement, peu importe le message 
d’invitation qui a été utilisé pour créer le compte, dans la mesure où 
les deux invitations ont été envoyées à la même adresse de courriel.

GESTION DES UTILISATEURS – DEMANDES DE 
FUSION

4

3

5

2

1
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6. Pour sélectionner un compte comme compte 
parent, allez à la section Titulaire du compte 
et choisissez le compte que vous souhaitez 
utiliser. Ensuite, ajoutez une note au compte 
(obligatoire).

7. Cliquez sur Envoyer la demande.

Une fois que les comptes auront été fusionnés, la 
demande de fusion sera envoyée à l’autre 
fournisseur, mentionnant le responsable.

GESTION DES UTILISATEURS – DEMANDES DE 
FUSION

7

6
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Leçon 4
Consulter et accuser 

réception d’un bon de 

commande (CSP)



36

Pour accéder au bon de commande, ouvrez une 
session dans le portail CSP en suivant les étapes 
ci-dessous.

1. Entrez votre courriel et votre mot de passe, 
puis cliquez sur le bouton Se connecter 
(obligatoire).

2. En cliquant sur l’avis dans la section 
NOTIFICATIONS, vous accéderez directement 
à la commande pour l’examiner et en accuser 
réception.

3. Vous pouvez également accéder à toutes les 
commandes en cliquant sur l’onglet 
Commandes. 

CONSULTER ET ACCUSER RÉCEPTION D’UN 
BON DE COMMANDE (CSP)

1

3

2
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4. Recherchez la commande en question en 
entrant le numéro de bon de commande 
dans le champ Recherche.

5. Cliquez sur le numéro de bon de commande 
pour l’afficher.

6. Accusez réception du bon de commande en 
cochant la case à côté du champ Accepté.

CONSULTER ET ACCUSER RÉCEPTION D’UN 
BON DE COMMANDE (CSP)

Le terme « accusé de réception » désigne 

uniquement une confirmation de réception de la 

commande par le fournisseur.

6

5
4
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Voici les étapes à suivre pour afficher l’accord de 
paiement d’un bon de commande. 

1. Entrez votre courriel et votre mot de passe, 
puis cliquez sur le bouton Se connecter 
(obligatoire).

2. Cliquez sur la section Commandes.

3. Cliquez sur l’hyperlien Numéro du BC pour 
afficher le bon de commande.

ACCORD DE PAIEMENT D’UN BON DE 
COMMANDE

3

1

2
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4. Vous pourrez voir les détails de l’accord de 
paiement pour le bon de commande.

5. Cliquez sur le bouton Créer une facture*.

6. Veuillez suivre les étapes indiquées sur les 
diapositives de la leçon 5 pour créer une 
facture.

ACCORD DE PAIEMENT D’UN BON DE 
COMMANDE

* Lorsqu’il y a un accord de paiement sur un bon de 

commande, quel que soit le montant, facturez 

toujours en totalité, une fois que le service est 

entièrement fourni, sinon la facture sera rejetée et 

contestée.

* Un processus de contestation sera déclenché si 

l’on envoie une facture rajustée.

5

4
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Leçon 5
Créer et gérer une facture
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1. Pour créer des factures en fonction d’un bon 
de commande, cliquez sur l’onglet 
Commandes.

2. Le champ Sélectionner un client affiche la 
liste de vos clients. Sélectionnez Olymel dans 
le menu déroulant (il s’agit d’une étape 
facultative, au cas où vous gérez plusieurs 
clients dans le portail CSP).

3. Pour transformer un bon de commande en une 
facture, cliquez simplement sur l’icône de 
création de factures (       ), soit les pièces de 
monnaie jaunes.

CRÉER UNE FACTURE À PARTIR D’UN BON DE 
COMMANDE

2

1

3



42

4. Dans le champ Facture No, saisissez le numéro de la 
facture (obligatoire).

5. Saisissez la date de la facture (obligatoire).

6. La modalité de paiement est établie par défaut à partir 
du bon de commande (obligatoire).

7. La devise est établie par défaut à partir du bon de 
commande.

8. La condition d’expédition est établie par défaut à partir 
du bon de commande. 

9. Pour le champ « Scan Image » (Numériser l’image), 
téléchargez les documents justificatifs affichant le libellé 
juridique (obligatoire).

10. Veuillez télécharger les documents justificatifs dans le 
champ Pièces jointes.

11. Cliquez sur l’icône de loupe pour sélectionner l’adresse 
pour les champs Adresse de l’émetteur de la facture, 
Coordonnées de paiement et Adresse 
d’expédition(obligatoire).

CRÉER UNE FACTURE À PARTIR D’UN BON DE 
COMMANDE

Veuillez noter que l’adresse de paiement entrée ici n’aura pas 
d’incidence sur le paiement des factures.

Si les champs Devise et Condition d’expédition sont remplis 
par défaut, veuillez ne pas modifier les valeurs.

4

5

6
7

8

9

10

11

Supplier 

ABC123

Supplier 

ABC123

Supplier 

ABC123

Supplier ABC123
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12. Dans la section Lignes, si vous choisissez Qté 
pour le Type, vous pouvez mettre à jour les 
champs Description, Qté, UDM et Prix, selon 
le cas.

13. Si vous choisissez Mnt pour le Type, vous 
avez la possibilité de mettre à jour les champs 
Description et Prix, le cas échéant.

14. Pour ajouter des taxes au niveau de l’en-tête, 
veuillez consulter la leçon 6.

15. Pour ajouter des taxes au niveau des lignes, 
veuillez consulter la leçon 7.

16. Dans la fenêtre contextuelle, cliquez sur le 
bouton Envoyer la facture.

17. Vous verrez un message indiquant que la 
facture est en attente d’autorisation.

CRÉER UNE FACTURE À PARTIR D’UN BON DE 
COMMANDE

Pour les lignes d’articles, veuillez choisir Qté pour le Type. 

Pour les lignes de services, veuillez choisir Mnt pour le Type.

17

16

13

12
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Nous verrons ici une autre façon de créer des 
factures à partir d’un bon de commande.

1. Cliquez sur l’onglet Factures.

2. Cliquez sur le bouton Créer une facture à 
partir d’un bon de commande.

3. Vous pouvez cliquer sur le bouton Créer une 
facture.

4. Suivez les étapes mentionnées aux 
diapositives de la leçon 5.

CRÉER UNE FACTURE À PARTIR D’UN BON DE 
COMMANDE – ONGLET FACTURES

3

2

1
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Leçon 6
Créer une facture dans le 

portail CSP (taxes au niveau de 

l’en-tête)
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Vous pouvez entrer les taxes au niveau de l’en-tête en suivant les étapes ci-dessous.

1. Faites défiler l’écran jusqu’à la section Total net des lignes de la facture.

2. Entrez les frais d’expédition/incoterm (2a), de traitement (2b) et divers (2c), le cas échéant.

3. Pour entrer les taxes dans l’en-tête de la facture, choisissez le code de taxe dans le menu déroulant 
du champ Taxes.

4. Par exemple, pour entrer les taxes pour le Québec, sélectionnez le code fiscal CA: QC – TPS – GST – 
5.0% et CA: QC – TVQ – QST – 9.975% dans le menu déroulant

5. Le taux d’imposition sera défini par défaut à partir du code de taxe choisi.

6. Le montant des taxes est calculé automatiquement en fonction du code de taxe choisi.

7. Cliquez sur l’icône « + » verte pour entrer la deuxième ligne de taxes, au besoin.

8. Cliquez sur Calculer pour recalculer le montant de la facture.

9. Le champ Taxes totales affichera le montant total des taxes calculé sur la facture.

10. Le champ Total net affichera le montant total de la ligne et des frais sommaires.

11. Le champ Total affichera le montant cumulatif des taxes totales et du total net.

12. Cliquez sur le bouton Envoyer pour soumettre la facture créée.

CRÉER UNE FACTURE DANS LE PORTAIL CSP 
(TAXES AU NIVEAU DE L’EN-TÊTE)

Veuillez ne pas modifier les renseignements sur le taux et le montant des taxes.

Vous ne pourrez pas entrer les taxes à la fois au niveau des lignes et de l’en-tête sur une facture.

Les codes de taxes entrés au niveau de l’en-tête calculeront les taxes sur la facture au complet, y compris le total de la 

ligne et le total des frais sommaires.

Veuillez ne pas entrer de taxes dans les champs de frais d’expédition, de traitement et divers pour les taxes au niveau de l’en-tête.

1

2a

2b

2c

3

9
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7
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5

6

10

12

8
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Leçon 7
Créer une facture dans le 

portail CSP (taxes au niveau 

de la ligne)
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7. Entrez les frais d’expédition/incoterm (7 a), de traitement (7b) et divers (7c), 

le cas échéant.

8. Pour entrer le taux des taxes (%) dans les champs Expédition/Incoterm (8a), 

Traitement (8b) et Divers (8c), sélectionnez le code de taxe dans le menu 

déroulant, s’il y a lieu*.

9. Le taux des taxes et le montant des taxes s’affichent par défaut en fonction du 

code de taxe sélectionné.

10. Cliquez sur l’icône « + » verte pour entrer la deuxième ligne de taxes, au besoin.

11. Cliquez sur le bouton Calculer.

12. Le champ Taxes totales affichera le montant total des taxes calculé sur la 
facture.

13. Le champ Total net affichera le montant total de la ligne et des autres frais.

14. Le champ Total affichera le montant cumulatif des taxes totales et du total net.

15. Cliquez sur le bouton Envoyer pour soumettre la facture créée.

CRÉER UNE FACTURE DANS LE PORTAIL CSP 
(TAXES AU NIVEAU DE LA LIGNE)

* Veuillez entrer les montants des taxes pour les frais d’expédition/incoterm, de 

traitement et divers dans les champs indiqués pour les taxes au niveau des lignes.

8c

7c

8b

7b

108a

7a

13

9

14

12

1511
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Leçon 8
Créer une note de crédit 

(CSP)
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On peut créer des notes de crédit de deux façons dans 
le portail CSP :

1. Résoudre le problème associé au numéro de 
facture : par exemple, résoudre un problème lié à 
des biens ou services pour lesquels une facture 
existe dans le système.

2. Autre (par exemple, rabais) : par exemple, émettre 
une note de crédit à un client pour lui offrir 
simplement un crédit, sans rajustement de facture.

CRÉER UNE NOTE DE CRÉDIT (CSP) 

Veuillez noter que la note de crédit doit être approuvée 

par Olymel pour les deux options.
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Ici, nous verrons comment créer une note de crédit pour 
résoudre un problème avec une facture.

1. Cliquez sur le bouton Créer une note de crédit dans 
l’onglet Factures du portail CSP.

2. Une nouvelle fenêtre s’affichera. Sélectionnez un 
motif pour créer la note de crédit : ici, « Résoudre 
le problème associé au numéro de facture »*.

3. Cliquez sur le bouton Continuer.

CRÉER UNE NOTE DE CRÉDIT – A) ONGLET 
RÉSOUDRE LE PROBLÈME ASSOCIÉ AU 
NUMÉRO DE FACTURE (CSP)

* Il y a deux options pour le motif, soit « Résoudre le problème 

associé au numéro de facture » et « Autre (par exemple, 

rabais) », qui permettent d’indiquer la raison pour laquelle on 

crée la note de crédit.

1

3

2
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4. Sélectionnez une option : « Annuler complètement la 
facture avec une note de crédit » ou « Ajuster la 
facture avec une note de crédit »*.

5. Cliquez sur le bouton Créer.

6. Entrez le numéro de la note de crédit (obligatoire).

7. Sélectionnez la date de la note de crédit (obligatoire).

8. Pour le champ « Scan Image » (Numériser l’image), 
téléchargez les documents justificatifs affichant le libellé 
juridique (obligatoire).

9. Cliquez sur l’hyperlien Fichier pour joindre les 
documents justificatifs (obligatoire).

CRÉER UNE NOTE DE CRÉDIT – A) ONGLET 
RÉSOUDRE LE PROBLÈME ASSOCIÉ AU 
NUMÉRO DE FACTURE (CSP) 

* Annuler complètement la facture avec une note de crédit : Cette option 

annulera la facture intégrale en créant la note de crédit. De plus, vous 

n’aurez pas l’option de modifier le montant ou la quantité.

* Ajuster la facture avec une note de crédit : Cette option vous permet 

de modifier le montant ou la quantité pour lesquels il faut créer la note 

de crédit, et la facture peut être partiellement modifiée.

7

6

5

4

9

8
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Faites défiler la page vers le bas jusqu’à la section 
Lignes.

10. Choisissez le type d’ajustement pour les lignes : 
Quantité, Prix ou Autre.

11. Entrez l’ajustement dans les champs Quantité 
(nombre négatif) ou Prix (nombre négatif) (ou les 
deux) en fonction du type d’ajustement que vous 
avez choisi, le cas échéant.

Faites défiler l’écran jusqu’au bas de la facture.

12. Cliquez sur Calculer pour recalculer le montant total 
de la note de crédit.

13. Les taxes sont automatiquement supprimées selon 
les mises à jour effectuées sur la ligne, et le champ 
Taxes totales le reflétera.

14. La facture est modifiée en fonction des données 
saisies. Cliquez sur Envoyer pour émettre la note de 
crédit.

15. Une fenêtre contextuelle s’affichera, vous demandant 
de confirmer votre action. Cliquez sur Envoyer note 
de crédit pour envoyer la note de crédit.

CRÉER UNE NOTE DE CRÉDIT – A) ONGLET 
RÉSOUDRE LE PROBLÈME ASSOCIÉ AU 
NUMÉRO DE FACTURE (CSP) 

1

110
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13
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15
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Nous verrons ici comment créer une note de crédit 
pour offrir un crédit au client.

1. Cliquez sur le bouton Créer une note de 
crédit.

2. Une nouvelle fenêtre s’affichera. Sélectionnez 
un motif pour créer la note de crédit : ici, 
« Autre (par exemple, rabais) »*.

3. Vous pouvez sélectionner un contrat dans le 
menu déroulant, s’il y a lieu.

4. Cliquez sur le bouton Continuer.

CRÉER UNE NOTE DE CRÉDIT – B) AUTRE 
(PAR EXEMPLE, RABAIS) 

4

23

1



55

5. Saisissez le numéro de la note de crédit (obligatoire).

6. Sélectionnez la date de la note de crédit (obligatoire).

7. Le champ Devise affichera la valeur CAD par défaut 
(obligatoire).

8. Pour le champ « Scan Image » (Numériser l’image), téléchargez 
le document de libellé juridique (obligatoire).

9. Veuillez télécharger les documents justificatifs dans le champ 
Pièces jointes.

10. Cliquez sur l’icône de loupe pour sélectionner l’adresse pour les 
champs Adresse de l’émetteur de la facture, Coordonnées de 
paiement et Adresse d’expédition(obligatoire).

11. Saisissez le courrier électronique du demandeur (obligatoire).

12. Saisissez le nom du demandeur (obligatoire).

CRÉER UNE NOTE DE CRÉDIT – B) AUTRE 
(PAR EXEMPLE, RABAIS) 

La note de crédit créée servira de note de crédit individuelle.

Pour une note de crédit individuelle, entrez NA dans le champ 

« Numéro de la facture originale ». Dans le champ « Date de la facture 

originale », entrez la date du jour.

7

6

10

5
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Supplier ABC123

Supplier 
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13.  Pour les lignes de services, veuillez choisir Mnt 
pour le Type.

14. Remplissez les champs Description, Qté 
(nombre négatif), UDM et Prix pour le Type Qté.

15. Remplissez les champs Description et Prix pour 
le Type Mnt.

16. Cliquez sur l’hyperlien Ajouter une ligne si vous 
devez ajouter d’autres lignes à la note de crédit.

CRÉER UNE NOTE DE CRÉDIT – B) AUTRE 
(PAR EXEMPLE, RABAIS) 

16

15

14

13
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17.  Cliquez sur Calculer pour recalculer le montant 
total de la note de crédit.

18.  La facture est modifiée en fonction des données 
saisies. Cliquez sur Envoyer pour émettre la note 
de crédit.

19. Une fenêtre contextuelle s’affichera, vous 
demandant de confirmer votre action. Cliquez 
sur Envoyer note de crédit pour envoyer la 
note de crédit.

CRÉER UNE NOTE DE CRÉDIT – B) AUTRE 
(PAR EXEMPLE, RABAIS) 

19

17 18
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Vous pouvez également créer une note de crédit à 
partir d’une ligne de commande.

1. Cliquez sur Commandes dans la barre de 
menus supérieure. 

2. Recherchez la commande parmi les options 
affichées dans la fenêtre Recherche.

3. Cliquez sur l’icône des pièces de monnaie 
rouges pour créer une note de crédit.

La page Note de crédit s’affichera.

4. Suivez les étapes des diapositives de la leçon 
5.

CRÉER UNE NOTE DE CRÉDIT – À PARTIR 
D’UN BON DE COMMANDE (CSP)

1

2
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Leçon 9
Factures contestées (CSP)



60

Si Olymel conteste une facture, elle affichera le 
statut « En litige » pour que le fournisseur prenne 
des mesures.

Il y a deux façons de régler les différends liés aux 
factures :

• Corriger la facture : Si la facture contestée 
contient des renseignements inexacts, veuillez 
choisir l’option Corriger la facture.

• Annuler : Si la facture contestée était en double 
ou a déjà été payée, vous pouvez utiliser l’option 
Annuler pour l’annuler.

FACTURES CONTESTÉES (CSP)
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Vous pouvez consulter les factures contestées 
dans la section NOTIFICATIONS ainsi que la 
section Factures. 

1. Placez votre curseur sur la section 
NOTIFICATIONS pour consulter les factures 
contestées.

2. Cliquez sur l’hyperlien de notification.

3. Dans la section Informations générales, vous 
pouvez vérifier les motifs du litige.

FACTURES CONTESTÉES – A) CORRIGER UNE 
FACTURE (CSP)

1

2

3
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4. Cliquez sur le bouton Corriger la facture.

FACTURES CONTESTÉES – A) CORRIGER UNE 
FACTURE (CSP)

4
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5. Corriger les renseignements sur la facture en 
fonction du motif du litige.

6. Cliquez sur le bouton Calculer.

7. Cliquez sur le bouton Envoyer.

8. Dans la fenêtre contextuelle, cliquez sur le 
bouton Envoyer la facture. La facture sera 
renvoyée à Olymel pour traitement ultérieur.

FACTURES CONTESTÉES – A) CORRIGER UNE 
FACTURE (CSP)

5

6 7

8
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Nous verrons ici comment annuler une facture 
contestée.

1. Cliquez sur la section Factures.

2. Sélectionnez En litige dans le menu déroulant 
Afficher.

3. Vous pourrez voir le motif du différend 
mentionné.

4. Cliquez sur l’icône Résoudre.

FACTURES CONTESTÉES – B) ANNULER UNE 
FACTURE (CSP)

1

2

3
4
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5. Cliquez sur le bouton Annuler.

6. Dans la fenêtre contextuelle, cliquez sur le 
bouton Oui.

7. Vous verrez un message indiquant que la 
facture a été annulée.

FACTURES CONTESTÉES – B) ANNULER UNE 
FACTURE (CSP)

5

6

7
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Si Olymel conteste une facture, elle affichera le 
statut « En litige » pour que le fournisseur prenne 
des mesures.

Il y a deux façons de régler les différends liés aux 
factures :

• Corriger la facture : Si la facture contestée 
contient des renseignements inexacts, veuillez 
choisir l’option Corriger la facture.

• Annuler : Si la facture contestée était en double 
ou a déjà été payée, vous pouvez utiliser l’option 
Annuler pour l’annuler.

FACTURES CONTESTÉES (CSP)
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Leçon 10
Avis demandant une action du 

fournisseur (SAN)
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Les avis demandant une action du fournisseur 
(SAN) permettent aux fournisseurs de donner suite 
à des bons de commande directement à partir des 
avis par courriel pour les bons de commande créés 
dans Coupa, à l’aide d’options pour gérer les 
commandes, accuser réception, créer une 
facture à partir d’un bon de commande ou ajouter 
un commentaire à un bon de commande.

Voici une capture d’écran d’un avis SAN qu’un 
fournisseur a reçue par courriel.

AVIS DEMANDANT UNE ACTION DU 
FOURNISSEUR (SAN)
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Vous pouvez accuser réception du bon de 
commande et gérer la commande à l’aide de la 
fonction SAN.

1. Cliquez sur l’icône Accuser réception du bon 
de commande.

2. Le bon de commande sera accusé de 
réception comme indiqué dans la capture 
d’écran.

3. Pour gérer la commande, cliquez sur le bouton 
Gérer la commande dans le courriel.

AVIS DEMANDANT UNE ACTION DU FOURNISSEUR 
(SAN) – ACCUSER RÉCEPTION D’UN BON DE 
COMMANDE ET GÉRER LA COMMANDE

1

2

3
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4. Vous avez la possibilité d’accuser réception du 
bon de commande en cochant la case 
Accepté.

5. Vous pouvez utiliser le bouton Créer une 
facture pour créer une facture pour le bon de 
commande, enregistrer le bon de commande 
et obtenir un aperçu d’impression.

AVIS DEMANDANT UNE ACTION DU FOURNISSEUR 
(SAN) – ACCUSER RÉCEPTION D’UN BON DE 
COMMANDE ET GÉRER LA COMMANDE 

4

5
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Voici les étapes à suivre pour afficher l’accord de 
paiement d’un bon de commande.

1. Cliquez sur le bouton « Gérer la 
commande » dans l’avis envoyé par courriel.

2. Vous pourrez voir les détails de l’accord de 
paiement sur le bon de commande.

3. Cliquez sur le bouton Créer une facture*.

4. Suivez les étapes décrites aux diapositives de 
la leçon 5 pour créer une facture.

AVIS DEMANDANT UNE ACTION DU FOURNISSEUR (SAN) – ACCUSER 
RÉCEPTION DU BON DE COMMANDE ET GÉRER LA COMMANDE 
(ACCORD DE PAIEMENT SUR LE BON DE COMMANDE)

* Lorsqu’il y a un accord de paiement sur un 

bon de commande, quel que soit le montant, 

facturez toujours en totalité, une fois que le 

service est entièrement fourni, sinon la facture 

sera rejetée et contestée.

* Un processus de contestation sera déclenché 

si l’on envoie une facture rajustée.

1

2

3
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Vous pouvez également créer une facture en utilisant 
la fonction SAN.

1. Pour ce faire, cliquez sur le bouton « Créer une 
facture »  dans le courriel.

2. Dans la fenêtre contextuelle, cliquez sur le 
bouton Créer des nouvelles coordonnées de 
paiement pour créer une adresse de paiement.

AVIS DEMANDANT UNE ACTION DU 
FOURNISSEUR (SAN) – CRÉER UNE FACTURE

1

2

Supplier

Supplier
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3. Entrez les renseignements requis et cliquez 
sur le bouton Créer et utiliser.

AVIS DEMANDANT UNE ACTION DU 
FOURNISSEUR (SAN) – CRÉER UNE FACTURE

3

Supplier
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4. Saisissez le numéro de facture dans le champ 
Facture No (obligatoire).

5. Saisissez la date de la facture (obligatoire).

6. Validez la devise (obligatoire).

7. Dans le champ Pièces jointes, cliquez sur 
l’hyperlien Fichier, URL ou Texte et téléversez 
les documents requis.

8. Vous pouvez entrer les taxes au niveau des 
lignes en suivant les directives à la leçon 7.

AVIS DEMANDANT UNE ACTION DU 
FOURNISSEUR (SAN) – CRÉER UNE FACTURE

Veuillez ne pas ajouter des taxes au niveau des lignes 

et de l’en-tête sur la même facture.

Les renseignements sur les versements seront 

conservés dans le système PGI d’Olymel; l’adresse de 

versement entrée dans le portail CSP n’auront aucune 

incidence sur le paiement des factures soumises.

4

5
6

7

8
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9. Vous pouvez entrer les taxes au niveau de l’en-
tête en suivant les étapes à la leçon 6.

10. Cliquez sur le bouton Calculer.

11. Cliquez sur le bouton Envoyer pour soumettre 
la facture créée.

AVIS DEMANDANT UNE ACTION DU 
FOURNISSEUR (SAN) – CRÉER UNE FACTURE

10
11
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Vous pouvez également ajouter des commentaires sur 
le bon de commande en utilisant la fonction SAN.

1. Pour ce faire, cliquez sur l’icône « Ajouter un 
commentaire » dans le courriel.

2. Dans la section Commentaires, ajoutez vos 
commentaires et cliquez sur le bouton Ajouter un 
commentaire.

AVIS DEMANDANT UNE ACTION DU 
FOURNISSEUR (SAN) – AJOUTER UN COMMENTAIRE

1

2
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Vous pouvez également résoudre un différend sur 
une facture en utilisant la fonction SAN.

1. Vous recevrez votre avis par courriel pour la 
facture contestée.

2. Accédez à votre avis SAN et cliquez sur l’icône 
« Créer une facture » pour afficher les factures 
contestées.

3. Suivez les étapes mentionnées aux 
diapositives de la leçon 9.

AVIS DEMANDANT UNE ACTION DU 
FOURNISSEUR (SAN) – FACTURES CONTESTÉES

1

2
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Leçon 11
Participation à un événement 

d’approvisionnement
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Une fois qu’un événement d’approvisionnement est 
lancé, le fournisseur reçoit par courriel un avis de 
participation.

Suivez les étapes ci-dessous pour participer à un 
événement d’approvisionnement et envoyez votre 
réponse.

1. Le fournisseur reçoit un avis par courriel 
annonçant l’événement d’approvisionnement. 
Cliquez sur le bouton Voir l’événement pour 
être redirigé vers celui-ci.

2. Saisissez le nom d’utilisateur et le mot de 
passe. Si vous êtes un nouveau fournisseur, 
vous obtiendrez un lien de réinitialisation de 
mot de passe où vous pourrez définir votre mot 
de passe pour ouvrir une session. Cliquez sur 
le bouton Se connecter*.

PARTICIPATION À UN ÉVÉNEMENT 
D’APPROVISIONNEMENT

**

1

2

Supplier

Supplier
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Vous pourrez voir tous les événements 
d’approvisionnement auxquels vous avez participé 
ou qu’on vous a invité, avec leur statut.

3. Cliquez sur l’hyperlien Énénement no.

4. Vous verrez une horloge indiquant l’heure de 
fin de l’événement.

5. Cochez la case « Je souhaite participer à cet 
événement ». 

6. Cliquez sur l’hyperlien du document de 
modalités sous Conditions générales pour les 
consulter, le cas échéant.

7. Sous la question « Acceptez-vous ces 
conditions générales? », cochez le bouton 
d’option Oui, le cas échéant.

8. Cliquez sur le bouton Envoyer au propriétaire 
de l’événement.

PARTICIPATION À UN ÉVÉNEMENT 
D’APPROVISIONNEMENT

3

4

5

6 7 8
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9. Le calendrier de l’événement s’affichera à titre 
de référence. Cliquez sur le bouton Entrer une 
réponse.

10. Saisissez le Nom de la réponse que vous 
envoyez au responsable de l’événement.

PARTICIPATION À UN ÉVÉNEMENT 
D’APPROVISIONNEMENT

10

9

Supplier ABC123
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11. Téléchargez et consultez les pièces jointes, le 
cas échéant. 

12. Remplissez les formulaires, le cas échéant.

13. Cliquez sur le bouton Enregistrer.

14. Saisissez les renseignements de l’article 
comme le Prix par unité (obligatoire), le cas 
échéant.

15.  Cliquez sur le bouton Enregistrer.

16. Vous pouvez aussi entrer les détails de l’article 
en cliquant sur le bouton Importer depuis 
Excel.

PARTICIPATION À UN ÉVÉNEMENT 
D’APPROVISIONNEMENT

11
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17. Cliquez sur l’hyperlien Modèle de réponse 
pour télécharger le modèle.

18. Entrez les détails propres à l’article et 
enregistrez le fichier.

19. Cliquez sur l’option « Choose File » (Choisir 
un fichier), et téléchargez le modèle de 
réponse.

20. Cliquez sur le bouton Démarrer le 
téléchargement.

21. Vous verrez un message indiquant 
« Importation Excel réussie. Pensez à 
soumettre vos changements ci-dessous. »

22. Cliquez sur le bouton Soumettre la réponse 
pour envoyer votre réponse à propos de 
l’événement.

PARTICIPATION À UN ÉVÉNEMENT 
D’APPROVISIONNEMENT

17
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21

22
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4. Saisissez le numéro de facture dans le champ 
Facture No (obligatoire).

5. Saisissez la date de la facture (obligatoire).

6. Validez la devise (obligatoire).

7. Dans le champ Pièces jointes, cliquez sur 
l’hyperlien Fichier, URL ou Texte et téléversez 
les documents requis.

8. Vous pouvez entrer les taxes au niveau des 
lignes en suivant les directives à la leçon 7.

AVIS DEMANDANT UNE ACTION DU 
FOURNISSEUR (SAN) – CRÉER UNE FACTURE

Veuillez ne pas ajouter des taxes au niveau des lignes 

et de l’en-tête sur la même facture.

Les renseignements sur les versements seront 

conservés dans le système PGI d’Olymel; l’adresse de 

versement entrée dans le portail CSP n’auront aucune 

incidence sur le paiement des factures soumises.

4
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RÉCAPITULATION DU 
COURS ET 
PROCHAINES ÉTAPES
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Félicitations, vous avez terminé le cours!

Vous pouvez maintenant :

• Vous inscrire au portail CSP

• Obtenir un aperçu de la page d’accueil du portail CSP

• Inviter de nouveaux utilisateurs et gérer les utilisateurs 
existants dans le portail CSP

• Visualiser et accuser réception d’un bon de commande (CSP)

• Créer une facture à partir d’un bon de commande

• Ajouter les taxes au niveau de l’en-tête de la facture

• Ajouter les taxes au niveau des lignes de la facture

ÉNONCÉ DES OBJECTIFS DU COURS
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Félicitations, vous avez terminé le cours!

Vous pouvez maintenant :

• Créer une note de crédit

• Résoudre les différends liés aux factures

• Afficher et répondre à un avis de bon de commande 
demandant une action du fournisseur (SAN)

• Participer à une activité d’approvisionnement et soumettre 
des réponses

ÉNONCÉ DES OBJECTIFS DU COURS
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Prochaines étapes & conclusion



MESSAGE 1

1. À partir du 3 juin 2024, un bon 

de commande est obligatoire 

pour toute facture émise

2. À partir du 1er novembre 2024, 

les factures sans bon de 

commande seront refusées

3.   Exceptions à la règle

‘’No PO no PAY’’ - Effectif le 3 juin 2024

AVRIL - MAI 2024 JUIN - AOÛT 2024 SEPT. - OCT. 2024 NOV. 2024

MESSAGE 2 – AFFICHÉ SUR 

LES AVIS DE PAIEMENTS

À partir du 1er novembre, les 

factures sans bon de commande 

seront refusées

1er RAPPEL

À partir du 1er novembre, facture 

sans bon de commande refusée

2e RAPPEL

ENTRÉE EN VIGUEUR

À partir du 1er novembre, facture 

sans bon de commande refusée

FOURNISSEURS



Nouvelle section du site Olymel externe consacré aux fournisseurs 

▪ Coupa en bref - Olymel S.E.C.
▪ Information sur Coupa

▪ Aide à l’utilisation, documentation, FAQ, formation

    Habilitation fournisseurs

Espace 

Fournisseurs

Dès le 8 avril

Formation sur Coupa offerte en format virtuel et autonome

▪ Tiers 1 & 2: session virtuelle 

▪ Tier 3: capsule de formation (autonome) sur l’Espace fournisseurs

Formation

Mi-mai

Différentes communications envoyées aux fournisseurs

▪ Lancement Espace fournisseurs, date go-live, prochaines étapes

▪ Invitation aux formations virtuelles et incitation à visionner formation autonome

▪ Annonce mise en service de Coupa (Go-Live)

▪ Rappel formation, Espace Fournisseurs, contact soutien

Communications

Avril à juin

https://www.olymel.ca/fr/espace-fournisseur/coupa-en-bref/
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Olymel a pour but d'optimiser l'utilisation de la plateforme Coupa par ses fournisseurs.

Pour approfondir la compréhension de l'outil CSP, des ressources additionnelles seront mis à 
disposition:

• Des capsules vidéos par leçon seront disponibles sur l'espace fournisseur pour référence 
future.

• Des sessions de Q&A dans les jours suivants le Go-live seront organisées afin de discuter des 
différents enjeux ou questionnements rencontrés.

À noter que le portail Coupa pour fournisseurs ne sera pas disponible avant le Go-Live. Olymel 
fera parvenir des communications à ce sujet.

Pour du soutien fonctionnel, veuillez communiquer avec [SupportPartenairesOlymel@OLYMEL.com]

PROCHAINES ÉTAPES
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Merci !
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